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Description
The WBK14 is a dynamic analog signal input module for the WaveBook data acquisition system. The
WBK14 provides a complete system to interface to piezoelectric transducers that include accelerometers,
microphones, force/pressure transducers, and others.

Reference Note:
Information regarding accelerometers begins on page 6 of this document module.

Each WBK14 channel has a:

• current source for transducer biasing
• high-pass filter
• programmable gain amplifier
• anti-aliasing low-pass filter
• simultaneous sample-and-hold (SSH) amplifiers

The gain, filter cut-off frequencies and current biasing levels are software programmable.

WBK14 includes a built-in programmable excitation source.  This source stimulates dynamic systems for
transfer function measurements, and serves as a reference signal for calibration.
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WBK14 Block Diagram

Current Source
WBK14 provides constant current to bias ICP transducers. Two current levels (2 mA or 4 mA) with
voltage compliance of 27 V can be selected via software. The bias current is sourced through the center
conductor of a coaxial lead and returns to the WBK14 by the outer conductor. The output impedance is
larger than 1 MΩ and presents virtually no loading effect on the transducer’s output. For applications that
do not require bias, the current source can be removed from the BNC input by opening a relay contact.
The current sources are applied to (or removed from) the input in channel groups of two; i.e.,
channels 1-2, 3-4, 5-6, 7-8.

High-Pass Filters (HPF)
Each WBK14 channel has three High-Pass Filters (HPFs) with a 3-dB cut-off frequency (Fc).  Two filters
are at 0.1 Hz and the other is 10 Hz.  The 0.1-Hz HPF filters are single-pole RC filters.  They are primarily
used to couple vibration signals.  The 10-Hz HPF is a 2-pole Butterworth type that can be used to couple
acoustic signals or attenuate setup-induced low-frequency signals; since these can reduce the dynamic range
of the measurement (for example when using tape recorders as signal sources).

Programmable Gain Amplifier (PGA)
The HPF removes the DC voltage from the input signal. A PGA amplifies the AC voltage with flat response
up to 500 kHz. Each channel has a PGA with 8 programmable gains (1, 2, 5, 10, 20, 50, 100, and 200) and
a software-controlled DAC for offset nulling. The WBK14 measures only bipolar signals up to 5 V peak.

Programmable Low-Pass Anti-Aliasing Filter
The first filter stage is a programmable 2-pole continuous-time low-pass filter. The filter provides more than
65 dB alias protection to the next filter stage. In addition, it fine-tunes the phase shift of the channel to
optimize the phase-matching between channels. At calibration, the phase shift of each channel is measured
and stored in an EEPROM that is read at configuration.
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 Programmable Low-Pass Filter, Switch-Capacitor
Most of the signal alias rejection is performed by an 8-pole Butterworth filter. This filter is implemented
with a switch-capacitor network driven by a programmable clock (timebase control). Each channel has an
independent clock whose frequency determines the 3-dB cut-off frequency of the filter. The switch-
capacitor filter provides no attenuation at the clock frequency—hence, the need for the continuous-time
low-pass filter.

Note: The Low-Pass Anti-Aliasing Filter can be bypassed to process signals with a bandwidth higher
than 100 kHz.

The External Clock input provides a path to externally control the cut-off frequency of the Low-Pass
Anti-Aliasing Filter. The input waveform can be TTL or sinusoidal, with an amplitude peak of at least
500 mV. In this mode, the cut-off frequency is set to the input frequency divided by 50.

Simultaneous Sample and Hold
All WBK14 channels are sampled simultaneously, after which the WaveBook measures each output at
1 µs/channel until all channels are digitized. The time-skew between sampling on all channels (up to 72)
is 150 ns, regardless of the number of WBK14s attached to the WaveBook.

When using WaveBook with an SSH channel enabled, the per-channel sample rates are
reduced.  The rate reduction is the same as that which would occur if another channel
were added.  The per-channel rate (with SSH enabled) is:

 1 MHz / (n+1), where n is the number of active channels.

Excitation Source
The excitation source includes a sine/random waveform generator, a programmable gain amplifier (PGA), a
DC-level DAC, and a phase-lock loop (PLL). The PLL is used to synthesize the frequency of a fixed-
amplitude sine wave and control the bandwidth of the random signals. The PGA conditions the signal
amplitude to a value between 0 V to 5 V peak. The DC level of the signal is varied independently of signal
amplitude by a software-controlled DAC from -5 V to +5 V. The DC level of the excitation signal can be
used to balance static loads, while the AC signal provides the dynamic excitation.

Calibration
WBK14 is calibrated digitally, eliminating the need for all potentiometers and manual adjustments.
WaveCal, a provided Windows-based program, simplifies the calibration process.

Reference Note:
The calibration program is detailed in the WaveCal Document Module.
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Hardware Setup
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If  the following two conditions exist simultaneously:

• operating WBK14s in a configuration of 4 or more modules
• ambient temperature >40°C;

then you must mount the modules on their side (vertically) to facilitate air flow
through the side plates.  Failure to due so could result in thermal-related problems.

Configuration
All WBK14 configurations are controlled by software. The WBK14 requires no hardware settings.

Reference Notes:
(1) Setup information pertaining to power, expansion control, and expansion signal connections is
contained in Chapter 3, System Setup and Power Options.

(2) You will need to set several parameters so WaveView can best meet your application
requirements.  For software setup information, refer to the “Software Setup” section in Chapter 3,
System Setup and Power Options.  For detailed WaveView information, refer to the WaveView
document module.

Power
Like the WaveBook, the WBK14 contains an internal power supply. The unit can be powered by an
included AC power adapter or from any 10 to 30 VDC source, such as a 12 V car battery. For portable or
field applications, the WBK14 and the WaveBook can be powered by the DBK30A rechargeable battery
module or the DBK34 uninterruptible power supply (UPS) / battery module.

You must compute power consumption for your entire system and (if necessary) use
auxiliary or high-current power supplies.

Reference Note:
Refer to Chapter 3, System Setup and Power Options for details regarding power.

Assembly
Physically, the WBK14 is the same size as the WaveBook for convenient mounting. A fastener panel allows
multiple units to be stacked vertically. Screw-on handles are available for portable applications. For more
assembly information, see chapter 3.



WBK14, Dynamic Signal Input Module                                            06-08-01 WBK14, pg. 5

Software Setup
Depending on your application, you will need to set several software parameters.  Proper settings will allow
WaveView to organize data to meet your requirements.  Some items of importance to the WBK14 are the
low-pass and high-pass filter options that can be selected from the WaveView Configuration main window
and the excitation source parameters that can be chosen from the Module Configuration window.  The
Module Configuration window can be accessed from the View pull-down menu or by use of the first toolbar
button (located just below the File pull-down menu).

Reference Note:
For more software setup information, refer to the “Software Setup” in chapter 3.
For detailed WaveView information, refer to the WaveView Document Module.

WaveView Configuration Window

In the WaveView Configuration main window (see figure) the following columns are
important in regard to filters.

LPF Mode –  You can click on a cell in the LPF Mode column to make the cell “active,” and
then change its setting.  Options for WBK14’s LPF Mode are:
          (a) On – turns the Low-Pass Filter on

(b) External – selects an external filter
(c) Bypass – bypasses the low-pass filter

LPF Cutoff – the cells in this column are used to set the Low-Pass Filter cutoff frequency.
HPF Cutoff – the cells in this column are used to set the High-Pass Filter cutoff frequency.

For WBK14 applications, the Module
Configuration window allows you to set
the excitation source in regard to:

amplitude
offset
waveform  (Sine, or Random)
frequency

The Module Configuration window can
be accessed from the View pull-down
menu or by use of the first toolbar button
(located just below the File pull-down
menu).

Module Configuration Window



WBK14, pg. 6                                                               06-08-01 WBK14, Dynamic Signal Input Module

Using Accelerometers with WBK14

Overview
A low-impedance piezoelectric accelerometer consists of a piezoelectric crystal and an electronic amplifier.
When stretched or compressed, the two crystal surfaces develop a charge variation that is related to the
amount of stress, shock, or vibration on the crystal.  The amplifier outputs a corresponding signal and
transforms the sensor’s high impedance to a lower output impedance of a few hundred ohms.  Note that, in
addition to acceleration, these sensors can also measure pressure and force.

The circuit requires only two wires (coax or twisted pair) to transmit both power and signal.  At low
impedance, the system is insensitive to external or “triboelectric” cable noise.  Cable length does not affect
sensitivity.

The following figure shows a simple sensor-WBK14 connection.  The voltage developed across R is
applied to the gate of the MOSFET.  The MOSFET is powered from a constant current source of 2 or 4 mA
and 27 volts.
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The MOSFET circuit will bias off at approximately 12 V in the quiet state.  As the system is excited,
voltage is developed across the crystal and applied to the gate of the MOSFET.  This voltage will cause
linear variation in the impedance of the MOSFET and a proportional change in bias voltage.  This voltage
change will be coupled to the WBK14 input amplifier through the capacitor C.  The value of R and the
internal capacitance of the piezoelectric crystal control the low frequency corner.  Units weighing only a
few grams can provide high level outputs up to 1 V/g with response to frequencies below 1 Hz.

Accelerometer Specification Parameters

Noise in Accelerometers

The noise floor or resolution specifies lowest discernible amplitude (minimum “g”) that can be measured.
There are two main sources of noise as follows:

• Noise from the crystal and microcircuit inside the accelerometer.  Some types of crystals, such as
quartz, are inherently more noisy than others.  A good noise floor is 10 to 20 µV.

• Noise from electrical activity on the mounting surface.  Since the signal from the accelerometer is a
voltage, 60 Hz or other voltages (ground loop, etc) can interfere with the signal.  The best protection is
to electrically isolate the accelerometer.

Sensitivity

The sensitivity of an accelerometer is defined as its output voltage per unit input of motion.  The unit of
motion used is “g.” One “g” is equal to the gravitational acceleration at the Earth’s surface, which is
32.2 ft/(sec)(sec) or 981 cm/(sec)(sec).  The output is usually specified in millivolts per “g” (mV/g).

Sensitivity is usually specified under defined conditions such as frequency, testing levels, and temperature.
An example: 100 mV/g at a frequency of 100 Hz, level +1 g, at 72°F.  Note that, although a sensor may
have a “typical” sensitivity of 100 mV/g, its actual sensitivity could range from 95 to 105 mV/g (when
checked under stated conditions).  Manufacturers usually provide sensor calibration values.
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Transverse Sensitivity  -  An accelerometer is designed to have one major axis of sensitivity, usually
perpendicular to the base and co-linear with its major cylindrical axis.  The output caused by the motion
perpendicular to the sensing axis is called transverse sensitivity.  This value varies with angle and frequency
and typically is less than 5% of the basic sensitivity.

Base-Strain Sensitivity - An accelerometer’s base-strain sensitivity is the output caused by a deformation
of the base, due to bending in the mounting structure.  In measurements on large structures with low natural
frequencies, significant bending may occur.  Units with low base-strain sensitivity should be selected.
Inserting a washer (smaller in diameter than the accelerometer base) under the base reduces contact surface
area; and can substantially reduce the effects of base-strain.  Note that this technique lowers the usable
upper frequency range.

Acoustic Sensitivity - High-level acoustic noise can induce outputs unrelated to vibration input.  In general,
the effect diminishes as the accelerometer mass increases.  Use of a light, foam-rubber boot may reduce this
effect.

Frequency Response

An accelerometer’s frequency response is the ratio of the sensitivity measured at frequency (f) to the basic
sensitivity measured at 100 Hz.  This response is usually obtained at a constant acceleration level, typically
1 g or 10 g.  Convention defines the usable range of an accelerometer as the frequency band in which the
sensitivity remains within 5% of the basic sensitivity.  Measurements can be made outside these limits if
corrections are applied.  Care should be taken at higher frequencies because mounting conditions greatly
affect the frequency range (see Mounting Effects, in upcoming text).

Dynamic Range

The dynamic measurement range is the ratio of the maximum signal (for a given distortion level) to the
minimum detectable signal (for a given signal-to-noise ratio).  The dynamic range is determined by several
factors such as sensitivity, bias voltage level, power supply voltage, and noise floor.

Bias Level

 Under normal operation, a bias voltage appears from the output signal lead to ground.  There are two basic
MOSFET configurations commonly used.  One exhibits a 7-8 V bias and the second a 9-12 V bias.
Operation of the two circuits is identical except for the available signal swing.  The low-voltage version
typically exhibits 5-10 µVrms versus 10-20 µVrms for the high voltage.

Thermal Shock - Temperature Transients

Piezoelectric accelerometers exhibit a transient output that is a function of a temperature’s “rate-of-change.”
This “thermal shock” is usually expressed in g/°C and is related to:

• Non-uniform mechanical stresses set up in the accelerometer structure.
• A pyroelectric effect in piezoelectric materials—an electrical charge is produced by the

temperature gradient across the crystal.

This quasi-static effect produces a low-frequency voltage input to the MOSFET amplifier.  This voltage is
usually well below the low-frequency corner, but the effect can reduce the peak clipping level and cause
loss of data.  This effect does not affect the accelerometer’s basic sensitivity or the data unless the thermal
shift in the operation bias level results in clipping.  Where drastic thermal shifts are expected, use 12 V bias
models.  The effect’s severity is related to the mass of the accelerometer.  In 100 mV/g industrial units, the
effect is usually negligible.  Using rubber thermal boots can reduce the effect significantly.

Overload Recovery

Recovery time from clipping due to over-ranging is typically less than 1 ms.  Recoveries from quasi-static
overloads that generate high DC bias shifts are controlled by the accelerometer input RC time constant that
is fixed during manufacture.

Power Supply Effects

The nominal power supply voltage recommended by most manufacturers is 15 to 24 V.  Units may be used
with voltages up to 28 volts.  Sensitivity variations caused by voltage change is typically 0.05%/volt.
Power supply ripple should be less than 1 mVrms.
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Connector

This parameter specifies the connector type and size (4-48, 6-40, 10-32 coaxial etc) and the location on the
sensor, that is, top or side (usually on the hex base).  Where there is no connector on the sensor, an integral
cable is specified with the length and the connector, that is, integral 6-ft to 10-32.

Electrical Grounding

Case-Grounded Design

In case-grounded designs, the common lead on the internal impedance matching electronics is tied to the
accelerometer case.  The accelerometer base/stud assembly forms the signal common and electrically
connects to the shell of the output connector.  Case-grounded accelerometers are connected electrically to
any conductive surface on which they are mounted.  When these units are used, take care to avoid errors
due to ground noise.

Isolated-Base Design

To prevent ground noise error many accelerometers have base-isolated design.  The outer case/base of the
accelerometer is isolated electrically off ground by means of an isolation stud insert.  The proprietary
material used to form the isolation provides strength and stiffness to preserve high-frequency performance.

Cable Driving
Operation over long cables is a concern with all types of sensors.  Concerns involve cost, frequency
response, noise, ground loops, and distortion caused by insufficient current available to drive the cable
capacitance.

The cost of long cables can be reduced by coupling a short (1 m) adapter cable from the accelerometer to a
long low-cost cable like RG-58U or RG-62U with BNC connectors.  Since cable failure tends to occur at
the accelerometer connection where the vibration is the greatest, only the short adapter cable would need
replacement.

Capacitive loading in long cables acts like a low-pass, second-order filter and can attenuate or amplify high-
frequency signals depending on the output impedance of the accelerometer electronics.  Generally this is not
a problem with low-frequency vibration (10 Hz to 2000 Hz).  For measurements above 2000 Hz and cables
longer than 100 ft, the possibility of high-frequency amplification or attenuation should be considered.

The WBK14 constant-current source provides 2 or 4 mA to integral electronics.  Use the higher current
setting for long cables, high peak voltages, and high signal frequencies.

The maximum frequency that can be transmitted over a given length of cable is a function of both the cable
capacitance and the ratio of the maximum peak signal voltage to the current available from the constant
current source:

Frequency Response to 5% of
Maximum Output Signal AmplitudeDrive Current

(mA)
Cable Length
@30 pF/ft (Ft)

± 1 V ± 5 V
2 10 185 kHz 37 kHz
2 100 18.5 kHz 3.7 kHz
2 1000 1.85 kHz 370 Hz
4 10 550 kHz 110 kHz
4 100 55 kHz 11 kHz
4 1000 5.5 kHz 1.1 kHz

f
K

C
V

Icc Ib

=

−






2π

Where:

f = Maximum frequency in Hz

K = 3.45 ×109.  K is the scale factor to convert Farads to picoFarads and Amperes to milliAmperes
and a factor to allow cable capacitance to charge to 95% of the final charge.

C = Cable capacitance in picoFarads

V = Maximum peak measured voltage from sensor in volts

Icc = Constant current from current source in mA

Ib = Current required to bias the internal electronics, typically 1 mA
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 WBK14 – Specifications

Name/Function: WBK14, 8-Channel Dynamic Signal Conditioning Module
Connectors: BNC connector, mates with expansion signal input on the WaveBook/512;

 two 15-pin connectors, mate with expansion signal control on the WaveBook/512; signals via 1 BNC per channel
Channels: 8
Gain Ranges: ×1, 2, 5, 10, 20, 50, 100, 200
Power Consumption: 15 Watts typical
Input Power Range: 10 to 30 VDC
Operating Temperature: 0°C to 50°C
Storage Temperature: 0°C to 70°C
Dimensions: 216 mm wide × 279 mm long × 35 mm high (8.5” × 11” × 1.375”)
Weight: 1.32 kg (2.9 lb)
ICP Current Source:
   Output Impedance: > 1.0 MΩ @ 20 kHz
   Compliance: 27 V
   Current Levels: 2 & 4 mA
Coupling : AC
   10 Hz High-Pass Filter - Input Impedance: 590K

   0.1 Hz High-Pass Filter - Input Impedance: 10 MΩ
Input Ranges:

 ±5.0 V, ±2.5 V, ±1.0 V, ±500 mV, ±250 mV, ±100 mV,
±50 mV, ±25 mV

Anti-Aliasing Low-Pass Filter:
   Accuracy: ±0.5 dB at the pass-band center
   Frequency Span: 30 Hz to 100 kHz
   Frequency Settings: 300 kHz / N; N = 3,4,...10000
   Dynamic Range @ 1 kHz: 69 dB
   THD @ 1 kHz: 70 dB
   Amplitude Matching: ± 0.1 dB
   Phase Matching:  ± 2°

Excitation Source:
   Max. Output Voltage: ± 10 V
   Max. Output Current: 10 mA
   DC Output: ± 5 V

   Sine:
      Frequency: 20 Hz to 100 kHz
      Distortion: < 0.1%
      Amplitude: ± 5 V
      Steps: 256
   Random:
      Spectral Distribution: White, Band-limited
      Amplitude Distribution: Gaussian
      Bandwidth: 20 Hz to 100 kHz
      RMS level: Adjustable in binary steps
External Clock:
   Digital: TTL levels
   Sine: > 500 mV peak
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